Design Principles And Usability Heuristics

You can avoid common design pitfalls by
following these rules-of-thumb for design

You can inspect an interface for usability

problems by applying these same
principles

James Tam

Design Principles And Usability Heuristics

Broad “rules of thumb” that describe features of “usable”
systems

Design principles
* Broad usability statements that guide a developer’s design efforts
* Derived by evaluating common design problems across many systems

An evaluation tool
» Same principles used to “evaluate” a system for usability problems

*Becoming very popular
- User involvement not required
- Catches many design flaws
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Design Principles And Usability Heuristics
(Advantages)

Discount usability engineering
* A few general guidelines can correct for the majority of usability problem
* Easily remembered, easily applied with modest effort
* Cheap and fast way to inspect a system
*Can be done by:

ety

s,

Usability experts End users
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Design Principles And Usability Heuristics
(Weaknesses)

Principles are more or less at the motherhood level
*Can’t be treated as a simple checklist

« Subtleties involved in their use
- Example:

Heuristics for many
collaborating users

Heuristics for a
single user

James Tam




1. Simple And Natural Dialogue

Use the user’s conceptual model

Match the users’ task in as natural a way as possible
* Minimize mapping between interface and task semantics
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1. Simple And Natural Dialogue
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1. Simple And Natural Dialogue

Menu or window? Which window?

Compuserve Information Manager
File Edit Services Mail Special Window Help
| — Services ‘

Telephone Access Numbers ‘

— Access Numbers & Logon ‘

United States and Canada
— United States and Canada
— CompuServe Network

List

|| ? List

List by:
State/Province
Area Code
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1. Simple And Natural Dialogue

Present exactly the information the user needs when it is
needed

e Less is more

- Less to learn, to get wrong, to distract...

*Remove or hide irrelevant or rarely needed information
- Competes with important information on screen

* Information should appear in natural order

- Order of accessing information matches user’s expectations
- Related information is graphically clustered

* Minimize or mitigate modes

*Use windows frugally

- Don’t make navigation and window management excessively complex

James Tam
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Alberta Health Care #: 45653-3357

Davison, Thomas
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Last Name: Davison Doctor: Jane Yang
Address: 4 BRADEN CRS Nw/ Insurer: FARMERS INSURANCE AGE
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Edit Prescription
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Citalopram

Folic Acid
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Good: Info in the same place

By previous 481 students Brant LeClercq, Lloyd Yoon, Amy Yang
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Mew Prescrption

See List Yiew

Alprazolam

Citalopram
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Folic Acid

Celecoxib .

Omeprazole I

Good: Info in the same place
Bad: Special edit mode

By previous 481 students Brant LeClercq, Lloyd Yoon, Amy Yang (with permission)
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By previous 481 students Brant LeClercq, Lloyd Yoon, Amy Yang (with permission)

Good: Stable parts of the window
Bad: Prescriptions separate
from graphics
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info

See List View

(mode buttons gone)
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Alprazolam

Citalopram
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Folic Acid

Levothyroxine

Celecoxib

Omeprazole

By previous 481 students Brant LeClercq, Lloyd Yoon, Amy Yang (with permission)
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2. Speak The User's Language

it ¥isual Basic

T

—
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2. Speak The User’s LLanguage

Terminology based on users’ language for task

T ~ioi TR FLE
Account total = $50.00 -
Maximum withdrawal of $50 Unable to complete operation!
at this time. Error code: 10225

| | G w | gm | 150

v X

Use meaningful mnemonics, icons, and abbreviations

+eg File / Save
- Ctrl+8S (abbreviation)
- AItFS (mnemonic for menu action)
- Open f (tooltip icon)

James Tam

3. Minimize The User’s Memory Load

*Describe required the input format, use examples, provide
default inputs

*Promote recognition over recall

&l Document1 - Microsoft Word

Fls Edt View Insert Format Tooks Table Window Help

O ew... Chrl+M B I U ‘
7 2 open... o
Close I
ST
& save Chl+5 _

Save fs...
[ Save as web Pags. .
Wersions...

Web Page Praview

Fage Setup...
[ print Preview
& print... Chrl+p

v X
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3. Minimize The User’s Memory Load

Small number of rules applied universally

File
11110000
01010101

Remove
what?

home

profs

tamj

N

231_temp 231 www
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3. Minimize The User’s Memory Load

Small number of rules applied universally

File
11110000
01010101

Remove

what?
home
profs
tamj

231_temp 231 www
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3. Minimize The User’s Memory Load

Small number of rules applied universally

File
11110000
01010101

Remove
what?

home

profs
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3. Minimize The User’s Memory Load

Small number of rules applied universally

File
11110000
01010101
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4. Be Consistent

Consistency of effects
* Same words, commands, actions will always have the same effect in
equivalent situations
* Makes the system more predictable
*Reduces memory load

James Tam

4. Be Consistent

Consistency of language and graphics
 Same information/controls in same location on all screens / dialog boxes
forms follow boiler plate
» Same visual appearance across the system (e.g. widgets)

-lolx] =Ty
Are you sure? Do wish to continue?
No I No ]
[~ e encounteredSN=TEY W=TE
Do wish to debug? Do you want to exit
without saving?
Yes No | Yes l

]
¥ x James Tam




4. Be Consistent

These are labels with a
raised appearance.

Is it any surprise that
people try and click on
them?

James Tam

4. Be Consistent

“J Peachpit Press - Features: Tips on Designing Web Pages - Microsoft Internet EXp

JFiIE Edt View Favortes Tools Help

L= @ & Qoeach GhFavortes Bty | B S B -HE B

| address [&] hep: fowaw. peachpic.comffeatures ndmenthjwebpages. himl

Peachpit
Press

1

Excerpted from Adobe's The Non-
Designer's Guerrilla Marketing CD

Two of the most important factors
in good web design are repetition
(consistency) and clarity. & wisitor
should never have to figure out how
to use your navigation system,
where they are in the site, or
whether they are still in your weh

site or have iumpoed somewhere
4

Tips on Designing Web Pages

by Robin Williams

Mon-Designer's
Month

Related Links
Bad/Good
Design
Checklists, from
The Mon-

Designer's Web
Book

Design
Drincinlac rmr1 _'LI
3

@ htkp: v, peachpit. comFeatures/excerptiindes. html

[ [ @ mtemet v
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4. Be Consistent

“F Peachpit Press - Books

crosoft Internet Explorer =] 3]
| Fle Edt vew Favorites Tools Help ‘

|+ [4=@ A 3| Qoearch Garavortes (Bristory | By S 55 -
| Address [] g fwm. peachit, com/becksfindex htmi =
Hame | Books
New Titles | Titles A-Z | Authors | Categories | Series | Backlist

Books
. By A~ a B

whether you rely on your computer and software skills
in your job or just like to mess around on a computer
at home, with more than two hundred high-quality
titles, there's a Peachpit book for you. Browse our lists

below:

Mew Titles Desktop Publishing

What's just out and what's

coming up. WWeb Design and

Publishing
A—T Ou Titla &
| »

@] http: ffumsve. peachpit.comyfindfindes himl [ |4 mtemet 4
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5. Provide Feedback

What is the program doing?

2 X

= Transfer Status

Sending BINARY fle arapdesn.itf (15577 bytes)

| 65% |
10240 233 Kbptes/s: 002
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5. Provide Feedback

/ What mode
am | in now?
FdinY

4

[ —
What did |
select? How is the
system
interpreting
my actions?
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5. Provide feedback

Should be as specific as possible, based on user’s input

T .ol [« Sovng.

Saving file heuristics.ppt
in notes folder

Best within the context of the action

wherte the cursor shape i.ndcic;l
the cursor from an arrow to 2|
“busy” mode (Figure 11), at |

Word is gaving doc.doc;, (EEEEEEE

James Tam




5. Provide feedback

Multiple files being copied,
but feedback is file by file.

Mow installing files. please wait. ..
Writing: E:\DRAWLTASAMPLESAS-06-20.¥LM

Percent Copied: 0% || | 100

Piess [Ezc] To Abort

Drawing Board LT
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5. Provide feedback

Feedback response time
* How users perceive delays

Delay Effect

0<= delay <= 0.1 seconds | Delay not noticed (system appears to operate
instantaneously)

0.1 <delay <=1 second | Delay noticed but train of thought remains
uninterrupted

1 <delay <= 10 seconds | Delay noticed but person can still remain focused on
the system

Delay > 10 seconds Person wants to do something else while waiting for

the system

James Tam




6. Provide Clearly Marked Exits

o
)

James Tam

6. Provide Clearly Marked Exits

Universal Undo/Redo
se.g., <Ctrl>-<Z> and <Ctrl> <Y>

Progress indicator & Interrupt
* Length operations

Sending BINARY fie grapdesn.itf (15517 bytes]

[ 65% | J

10240 2,33 Kbytesds : (:02
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6. Provide Clearly Marked Exits

Example: A text-based space simulation game

e 0123
I"-|||||||||\ -
L0 18 1 ael 1 O'\'I[/'
20 16 1111 1| «tH}> :‘)"&‘i’s:;e"‘

ap 11 LI | | -
__________ The “galaxy”
50111 [ I

B r e ZI:/III\'_I_
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6. Provide Clearly Marked Exits

do

insideGalaxy = isEmpty = withinRange = true;

System.out.print("Enter the destination row (0 —9): ");

row = Console.in.readInt();

System.out.print("Enter the destination column(0 — 9): ");

column = Console.in.readInt();

if ((row < 0) || (row > (Galaxy.SIZE-1)) || (column < 0) || (column > (Galaxy.SIZE-1)))

{
insideGalaxy = false;
System.out.println("You cannot move outside the galaxy"); Loop while

input is
invalid

}

hile ((insideGalaxy == false) || (isEmpty == false) || (withinRange == false));

James Tam




6. Provide Clearly Marked Exits

do

insideGalaxy = isEmpty = withinRange = true;
System.out.print("Enter the destination row (0 — 9, -1 to pass): ");
row = Console.in.readInt();
if (row ==-1)
{
System.out.println("You have chosen not to move your ship.");
break;
}

System.out.print("Enter the destination column(0 — 9, -1 to pass): ");

column = Console.in.readInt();

} while ((insideGalaxy == false) || (isEmpty == false) || (withinRange == false));

Allow the
user an
option to
opt out

James Tam

6. Provide Clearly Marked Exits

Restoring defaults
* Getting back original settings

BUY/SELL

CURRENT SHIP ]
CLRRENT SHIF 615,000
CREDITS 20,000
TOTAL CREDITS 635,000

P SHIPS COST

Heretic - 390,000
Faldari Mk i1 T e 485,000 Velacia
Fraij o [

Froij Mk i G00,000

Valacia = | 190,000

Wing Commander: Privateer © Origin-EA
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7. Provide Shortcuts

Keyboard accelerators

[€] Microsoft PowerPoint - [hci_heuristics.|

J Draw ~ ’E ¢ | Aushapes+ ™ "w [
J@,E\T Edit Yiew Insert Format Tools

J 0 O wew... Ctrln
J i = Open... Chri+0
Close
e
L u Save Chrl+5
3C

Save As...

o = [ Save as web Page...

Name completion

JF\\e Edit  Yiew Favoritss Tools  Help

| epack - =5 - @D [ | Doearch GFavortes (Frisoy [y S0 - « O PR
J Address I ktp:jipages.cpsc.ucalgary.caf~tam|
Jmks @Cu http:f/pages.cpsc.ucalgary. ca/~tamj
httpif/pages.cpsc.ucalgary. cal~tamji2001 /461
http:{jpages.cpsc.Uc algary. caf~tamj 2002{203
http:f/pages.cpsc. ucalgary, ca) ~tamji 2002203  assignments/ a7 wing_chun.ppt
http:f/pages.cpsc.ucalgary, ca~tamji 2002203  assignments/assignment 4, html
http:/pages.cpsc. ucalgary, ca/ ~tamj/ 2002203  assignments/assignments. html
bitp:ifpanes, cosc,ucaloary, cal~tamit2002i203  assianments/assionmentf. html

James Tam

7. Provide Shortcuts

Experienced users should be able to perform
frequently used operations quickly

* Type-ahead (entering input before the system is ready
for it)

*Navigation jumps
- e.g., going to window/location directly, and avoiding
intermediate nodes

* History systems
- WWW: ~60% of pages are revisits

James Tam




Keyboard

accelerators for & Microsoft PowerPoint - [M_heuristics]
menus 1] Fie Edit Wew Insert Format Tools Siide Show Window Help 18]
0 ?/ﬂ\éw & i:;,&|n ik %'|ﬂ |’E| &g @ 0% '|@”HJ“EditTa§tm -
Arid - 14 '|B1HS _E|<:d>”” 5

Customizable
toolbars and \an
palettes for
frequent actions

Split menu, with =
recently used %
fonts on top %
¥
B

Double-click
raises toolbar _\

dialog box

O=m=oo :
- D WG}‘AgtoShapes-\ \DOJ|&'£'A'EiE.e‘
Double-click clids 17 of 45 [ i_involving_user.ppt X
raises object- = — -
specific menu j

Scrolling controls
for page-sized
increments
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8. Deal With Errors In A Helpful And
Positive Manner

People will make errors!

Errors we make
* Mistakes
*Slips

Image and sound file from “The Simpson's”

James Tam




8. Deal With Errors In A Helpful And
Positive Manner

Mistakes
« Arise from conscious deliberations that lead to an error instead of the

correct solution
& Microsoft PowerPoint - [heuristics.ppt]

B) ke Edt Yeew Jrsert Fgrmat T W Wimdow b

DFEds &7 EY

Gatht 3. olaboration §

5 5.0cal With Errors In A Hm—
And Positive Manner Lustomize....

Mizakes Qptors.

Slips
* Unconscious behavior that gets misdirected en route to satisfying goal

* Shows up frequently in skilled behavior
- Usually due to inattention

* Often arises from similarities of actions

James Tam

Types Of Slips

1) Capture error
2) Description error
3) Loss of activation

4) Mode error

James Tam




Tvypes Of Slips: Capture Error

Frequently done activity “captures” the intended activity
* Occurs when common and rarer actions have same initial sequence
*“Force of habit results in the slip”

T can't
believe I
pressed
Yes...

Microsoft PowerPoint [X]

@ Do you want to save the changes you made to M_heuristics?

Mo I Canicel I

James Tam

Types Of Slips: Description Error

Intended action has much in common with others that are
possible
* Usually occurs when right and wrong objects physically near each other

*“Perform the right action but on the wrong object”
- e.g., Pour juice into bowl instead of glass

www.baddesigns.com
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Types Of Slips: Description Error (2)

DeEdey SRV

Print
preview??

W Db - Outhook Express

Outlook Express

Oops! | only meant for that
letter to only go to one person.

James Tam

Types Of Slips: Loss Of Activation

Loss of activation

* Forgetting what the goal is while undergoing the sequence of actions

- e.g., Start going to room and forget why you are going there
*“What the heck was I doing again?”
* Misordering a sequence

James Tam




Loss Of Activation

can be overdons
#/| 51 Web browser
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Loss Of Activation (2)

5 Microsoft PowerPoint Help

Select topic to display:

About handouts

Troubleshoot printing

Set up the shide size for printing
Make changes to notes pages

» Can [ have more than
one notes page for a
single side?

» When [ print my
notes pages [ don't see
al the text that |
entered into the notes
pane.

» 1formatted my notes

text, but the formatting
5 not showing.

Handouts

» Iwant a three-sides-
per-page handout but
without the ruied ines

for audence notes.

b [wanttorepintonly |

James Tam




Loss Of Activation (3)

BT o
He - 86 _

v Show Al
Contents Answer Wizard | jndex | =
Troubleshoot
what wiould you ke to notes and
|How do T print multiple slides per page? handouts
I—I Notes
e & (o 1 have voe )
Selact display: one notes page fora
e Engle shje?
| Troubleshoot notes and handouts |
Ahout handouts There is only one notes
Troubleshoot printing page per side. The text
Set up the slide size for printing AutoFt feature in
Make changes to notes pages Microsoft PowerPoint
helps in fitting text to
the placeholder by
reducing the font size ¥
there's text overflow.
To verify that AutoFt s

James Tam

Loss Of Activation (4)

"3 Microsolt PowerPoint Help

Mt ok you bhe o notes and
[How &5 print multipie sides par page? hand

b Can T have more than
Sabedt jopet 10 drsplay! one notes page for 3
ErTrTr—
About hardouts » When [ prnt my
Troubleshoot prnting miotes pages [ don't see
St up the shde sirw for prnting al the text that |
Maky Changes 1o nolbis pages ertered into the notes

pane.

» [ formatted my notes
text, but the formattng
& not showing.

Handouts.

s 1 want a theee-sides
per-page handout but

wiEhout the rued Ines|
for audence rotes,

James Tam




Loss Of Activation (5)
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MI 3 Tochooe the
3 . page onentiton,
2 ek Portrait 8]
2 o or o o Landscape &1
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) Pt handouts
Pt 4. To st headers ang
H Pretectus gages v
[ ————— i ]
I Fax 3 presentabon
B Trowieshoot proting ey
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W Opererg Saeng Bnd Convenng Prasies Footer!
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why Print What
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M Micronol Powed ot VBA Languags Rele
B Language Specihc Festrss eyt option
¥ou want
& Onthe File
men, pont ko
Send to, cick
Microsoft
Word, s
then select 3
nyoust opton.
6. On the Print
Preview oot
ack print S
Mote ¥ you want i
Fandouts n cokr, ||
o the File menu, dick
Preview
On the View manu,
port ta
| | and ]
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Loss Of Activation (6)

M
e - S0

Contents | Answer Wizard | jndex |

& (3 Microsoft PowerPoint Help
(2] Microsoft PowerPoint Help Center
@ @ End-User License Agreement (Retail)
& @ Getting Stanted
w @ Microsoft PowerPoint Accessibility
« @ Creating Presentations
@ Running Presentations
= {3 Printing Presentations

@

2 About print lack and white
7] Setup the sh @ for printing

2] Turn backgro nting on or off

7] Print slides
) Print handouts

7] Pnnt an outline

2] Print notes pages

3 Pont reviewer comments

7] Faxa presentation

2] Troubleshoot printing

2 Troubleshoot printing hidden shdes

vshowal &l
About printing

You can prnt your
entire presentation —
the sides, outine, notes
pages, and audience
handouts — in color,
grayscale, or pure black
and white. You can also
print spedific siides,
handouts, notes pages,
or outiine pages.

» Color, black and
whte, or grayscale
» Sides and
transparences

» Outine, notes pages,
and handouts

James Tam




Loss Of Activation (7)

Contents | Answer Wizard | Index |
= () Microsol PowsrPoint Help
2 Microsoft PowerPoint Help Certer
4 @ End-User License Agreemant (Retail)
# @ Gefing Started
a1 @ Microsolt PowerPoint Accessibility
= @ Creatng Presentations
+ @ Running Presentstons
= ) Printing Presentations
@ Avout panbing
) About printing in black and white
3 Setup the shide size for printng
g Tum background prniing on or off

(@ Print reviewes Fomments

7] Fax a presentation

@ Troubleshoot prinking

@) Troubleshoot prnting hidden shdes
= @ Opening. Saving and Converting Presenta
1 @ Working on a Presentaton with Other Peop
%) @ Working on he Web
% @ Instaling and Customaing Microsoh Power
# @ Ofice and Windows Basics
= @ Handwritng and Speech R
Secunty
< @ Managing and Printing Files
= @ Miciosoft PowerPoint VBA Language Refe
+ @ Language-Specic Features

|

Print slides

If you are Creating transparences for an
overhead projector, use this procedure
10 print out your presentation on
transparent sheets. Microsoft

t aly your
sides to pant to the prnter you have
selected — ether black and white or
oo,

1. Set up the side sire for printing.
b How?

2. Tosee what your sides wil bok ke
when they prnt, on the File menu,
cick Print Preview, and make any
changes you want.

3. Onthe Print Preview toobar, n
the Print What box, cick Shides.

4, On the Print Preview toobar, cick
print S

Note If you want to print out sides in

color, on the View menu, point to

Color [ Grayscale, and then cick Color,

You must have a color prnter selected

as your default printer to preview the
sides in color in Print Preview.

James Tam

Loss Of Activation (7)

Contents | Answer Wizard | jndex |

= () Microsol PowerPoint Help
A Microsolt PowerPomt Help Center
4 @ End-User Liconse Agreemant (Retail)

o =]

Print slides

If you are creating transparencies for an
overhead projector, use ths procedure
to print out your presentation on

. Microsoft

+ @ Running Presentabons

= () Printing Presentations
@ About prinng
) About panting in black and white
) Setup the siide size for printing
@ Tum background printng on or off

7] Fax a presentation

@ Troubleshoot printing

) Troubleshoot pnnting hidden shdes
= @ Opening. Saving, and Converting Presenta
5 @ Worong on a Presentation with Oher Peop

= @ Worang on he Web

5 @ Instaling and Customizing Micros ol Power
+ @ Ofice and Windows Basica

= @ Hand, g and Speech R

+ 4 Sacunty

Managing and Printing Files

1 @ Microsoft PowerPoint VBA Language Refe
# @ Language-Speciic Features

S0 sheets

PowerPoint automatcaly optimizes your

sides to prnt to the printer you have

selected — either biack and white or
color,

1. Set up the side size for printing.

» How?

2. To see what your sides wil ook lke
when they prnt, on the File menu,
cick Print Preview, and make any
changes you want.

3. Onthe Print Preview toobar, n
the Print What box, cick Shdes.
4. On the Print Preview toobar, cick

print S

Note [f you want to print out sides in

color, on the View menu, point to

Color/Grayscale, and then cick Color,

You must have a color printer selected

as your default printer to preview the

sides In color in Print Preview.

What was I trying
to do again???

James Tam




Types Of Slips: Mode Error

Mode errors
* People do actions in one mode thinking they are in another mode

Game is in multiplayer
mode only (cannot
load saved games)

< >

James Tam

Types Of Slips: Mode Error (2)

Mode errors
* People do actions in one mode thinking they are in another mode

Game is single and
multiplayer mode (can
start new campaigns
or load existing
games)

< >

James Tam




Types Of Slips: Mode Error (3)

Mode errors
* People do actions in one mode thinking they are in another mode

In this mode it is
possible to load a
game

James Tam

Designing For Slips

General rules
* Prevent slips before they occur
* Detect and correct slips when they do occur
+ User correction through feedback and undo

Examples
* Capture errors
- One action captures another
- Allow actions to be undone rather than asking for confirmations
* Description errors
- Correct action on the wrong object
- Make objects look physically distinctive and/or far apart
* Loss of activation
- Forgot goal
- If system knows goal, make it explicit
- If not, allow person to see path taken or shorten steps
* Mode errors
- Mistake modes
- Have as few modes as possible (preferably none)
- Make modes highly visible

James Tam




Generic System Responses For Errors

General idea: Forcing functions

* Prevent / mitigate continuation of wrongful action
- e.g., range selection for dynamic queries

Gag
* Deals with errors by preventing the user from continuing
- e.g., cannot get past login screen until correct password entered

Warn
* Warn people that an unusual situation is occurring

* Better than nothing but when overused, becomes an irritant
- e.g., audible bell, alert box

James Tam

Generic System Responses For Errors (2)

Warning (probably needed)

Format £ Ax = = = :
Capacity: B WORKSPACE amg on Eam) on tami an Caniy
| |—]L-. 2GB :J (En) reptune.cp... thor.pe.cpe... ‘new.cpscu,.
File system
[FaT22 k|
Allpe ation unit sien
I |Det st adocation sze =
Wodume label
| workseacE
Forimat cpkicns
I Quidk Format £
I ik —!S TWﬂm:WnnMer&Auduamthudﬁ
o format the dsk, dick O, To quit, click CANCEL.
o | e |
Start close | ]
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Generic System Responses For Errors (3)

Warning (can get annoying)

(w Deletefie N [w] Y]

Are you sure?

Yes No

James Tam

Generic System Responses For Errors (4)

Do nothing
« Illegal action just doesn’t do anything

* User must infer what happened
- e.g., enter letter into a numeric-only field (key clicks ignored)
- e.g., put a file icon on top of another file icon (returns it to original position)

Self-correct
* System guesses legal action and does it instead - but leads to a problem of

trust
- e.g., spelling checkers

Lets talk about it

* System initiates dialog with user to come up with solution to the problem
- e.g., compile error brings up offending line in source code

James Tam




Generic System Responses For Errors (5)

Teach me
+ System asks user what the action was supposed to have meant
* Action then becomes a legal one

Error Handling In “The Good Ole Days”

Go T
ERRGR 153452

What is “error 15762"?

mes Tam




Errors: Don’t Make Things Seem Worse Than
They Really Are

Time to
find
another line
of workl

Nt

James Tam

Rules Of Thumb For Error Messages

1. Polite and non-intimidating

* Don’t make people feel stupid
— Try again, bonehead!

2. Understandable
¢ Error 25

3. Specific
» Cannot open this document
» Cannot open “chapter 5 because the application “Microsoft Word”
is not on your system

4. Helpful
» Cannot open “chapter 5 because the application “Microsoft Word”
is not on your system. Open it with “Teachtext” instead?

James Tam




Examples Of Dealing With Errors In A Positive And
Helpful Manner

Prevent errors
* Try to make errors impossible

* Modern widgets: only “legal commands” selected, or “legal data” entered

.
BiEE

General Altendees] Notesl Plannerl
Date —Wherl

Start: | 8:304M 3: Wed 5 /14 /97 7]
e [ Al day
End: | 4:30PM HC Wed 5 /14 /97 7|
Month  Day  Year o
hiay 1937 ja
Description:
May (22 |1997

Smart Technology Sel
bonth  Day  “ear

May =[22 =[1997 -

12223 24
256 26 27 28 29 30 31

1234586 7 | ——
) Where:

Provide reasonableness checks on input data
* On entering order for office supplies
- 5000 pencils is an unusually large order. Do you really want to order that many?

James Tam

Examples Of Bad Error Messages

ImageReady

Could not fully start the application because a
pointer was nil when it should not hawve been

Cancel Help |

Click this to display an averview of this dialog box, idiot.

For Help on anitem, click '# at the top of the dialog box, and
then click the item

Adobe's ImageReady

AutoCAD Mechanical

Copy Profile Error x|

0 The operation completed successully.

ok |

Microsoft's NT Operating System

James Tam




Examples Of Bad Error Messages (2)

Microsoft Data Link Microsolt Access [ ]

& Unespected Enor. Please investigate. &

Ja

Outlook Express

& There was an eror opening this message.

An emar has oocured.

James Tam

Examples Of Bad Error Messages (3)

ch | mic

“Broduct
Suppo#: 4 Microsoft

Services

Home | Search | FAQs | Downloads | Newsgroups | Contact Us | Francais |

| send @ | print & | Hetp @

Error Message: Your Password Must Be at Least 18770 Characters and Cannot Repeat Any of
Your Previous 30689 Passwords (Q276304)

The information in this article applies to:

» Microsoft Windows versions 2000 , 2000 SP1 , Professional
» Microsoft Windows versions 2000 , 2000 SP1, Server
* Microsoft Windows versions 2000 , 2000 SP1 , Advanced Server

SYMPTOMS

If you log on to an MIT realm, press CTRL+ALT+DELETE, click Change Password , type your existing MIT password, and then
type a new, simple password that does not pass the dictionary check in Kadmind, you may receive the following error

message:

vour passward must be at least 18770 characters and cannot repeat any of your previous 30689 passwards
Please type a different password, Type a password that meets these requirements in both text bozes,

Mote that the number of required characters changes from 17,145 to 18,770 with the installation of SPL.

NOTE : This is not a comman case; it occurs only when you configure Windows 2000 to authenticate against an MIT Kerberos
domain,

James Tam




9. Provide Help

Help is not a replacement for bad design!

Volume 37:
A user's

Simple systems: guide to...
* Walk up and use; minimal instructions

Most other systems:
* Feature rich
* Some users will want to become “experts” rather than “casual” users

* Intermediate users need reminding, plus a learning path (novice to
advanced)

James Tam

Documentation And How It’s Used

Many users do not read manuals
* Prefer to spend their time pursuing their task

* Paper manuals unavailable in many businesses!
- e.g. single copy locked away in system administrator’s office

Typical usage scenarios:
* Usually used when users are in some kind of panic, need immediate help
- Indicates need for online documentation, good search/lookup tools
- Online help can be specific to current context
» Sometimes used for quick reference
- Syntax of actions, possibilities...
- List of shortcuts ...

James Tam




Types Of Help

Reference Manuals

Reminders
*Reference cards
*Keyboard templates

Context-sensitive help
*Tool tips
* What’s this (Balloon help)
Wizards

Tips

James Tam

Reference Manuals

Traditional form of help
< = S B
Detalled Qontenlslﬂnswerleald Index | |

Change the security level for
macro virus protection

1. Type keywiord:
L) RIS 1. ©n the Tools menu, point to

Paper or online [action S (e, s e (9 Crerasi.
Clear ﬂ Show Me

z. Click the Security Level tab, and
2. Or choose keywords then select the security level vou
want to use.

Learn about using security levels,

MNote If you are a macra
developer, you can learn about
how security levels and digital
activation - signatures work together in
_I Microsoft Word.

Additional resources

3. Chooss a tapic (20 Found)

FReepeat your last action

Use the Lotus NotesFlow Action menu
About outling view

Undo mistakes

Set the impartance level for a message
Flag a message for Follow up
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Reference Manuals

Traditional form of help

Detailed

Paper or online

°
Office 2000

Sec

y [2] ]

Trusted Sources I

& High. Only signed macros From trusted sources will be
allowed to run, Unsigned macros are aukomatically
disabled.

€ Medium, You can choose whether o nat to run
potentially unsafe macros.

 Low (nok recommended), You are nat pratecked fram
patentially unsafe macros. Use this setting only if you
hawe virus scanning software installed, or you are sure
all documents you open are safe,

o virus scanner installed,

Cance

Microsoft Word Help [_ (O] ‘
S YT

1ge the security level for
ro virus protection

4 the Tools menu, paint ta
acro, and then click Security.

| show me

ick the Security Level tab, and
en select the security level you
ant ta use.

:arn about using security levels.
ote If you are a macro
:veloper, you can learn about

e security levels and digital

anatures work together in
crosoft Word.,

iditional resources

| |Flag a message Far follow up

James Tam
.
Reminders
Short reference cards
- Expert user who just wants to check facts
- Novice who wants to get overview of system’s capabilities
Fire oI A A08 B . . Spacebar Cycle through Multi-Function Display .... F1
Select Weapon/Group ............ Enter DISPLAYS
Chain-Fire/Group-Fire Toggle ................ \ Radar Display (Normal/Full Screen/OFF) . . F2
Alpha Strike . P Damage Display R F5
Add Weapon to Group 1-5 .. ... .Shift+1-5 HTAL (Head/Torso/Arms/ Legs)
Fire Group 1,2, 3 Num Lock, /, * (Keypad) Armor Damage Report ........... ...F6
Fire Current Group ... Ceeennd Enable/Disable/Save/HUD Fi1
Jettison Ammunition v Remove Cockpit U
Objectives/Briefing Summary F12
Cycle Through All Targets T CAMERAS
Previous Target R R W e n s w Satiw meiotarara ¥1e Ff
Target Nearest Enemy . . = - Rear View F7
Target Friendly (Lancemate) .............. F DWW o F8
Target Object Underneath Reticle . .0 Weapon View Fa
Inspect Targeted Object . . . o Weapon View (Full Screen, After Launch) F10
Targeting OFF . .. .. Ctr+T
From “Mechwarrior 2: Mercenaries” © Microprose James Tam




Reminders (2)

Keyboard templates

- Shortcuts/syntactic meanings of keys; recognition vs. recall;

GUNSHIE

- \
+
Down
FAST

e WEAEGHS

manax
CANNON | JAMME] HAFF  JAMME: FLAKE ~ ACCEL NEXT
"{?g.g_qr:_ :__ Coniorr | becor | To TADS

AMIGA™S

Keyboar

‘R ol Wl O b O 1 5
vOLUME MAP | ROTATE | STOF | ROTATE .
SOUAND LEFT  ROTATION RIGIT LEFT
0N /OFF) =
From “Gunship” © Microprose James Tam

Context-Sensitive Help

Tool tips

SR
= A ol
= Insert Chart

?

Chart

Creates a chart by insering a Microsoft Graph object.

working with
- Macintosh “balloon help”
- Microsoft “What’s this” he

brief help explaining wh

James Tam




Wizards

Prezentation Conference Wizard

or audi

Ask each person For the name of their cormputer or their
Internet address as it appears in this wizard on their
computer, Enter that information belaw,

Computer name or Internet address:

Slide show details

il |

Zonnection information

Connection d

Finish

;I Bemove |

Open List. ..

Sawve st . |
=

Cancel = Back I [est = I

i

James Tam

5

Advanced features

Point out incorrect use

Change Awareness

« What is change awareness

« Why is it an important area of study
« Issues in change awareness

+ Future work

James Tam




Advanced features

Point out incorrect use

[ 3
3 Text is too small

Some of the text in this
placeholder might be too small
for your audience 1o read.

® Change text to be at least
Chal == point

® Ignore this style rule for
this presentation only

* What is change aware] ® Changs styls chacker
.. . options for all presentations
* Why is it an important
™ Don't show me this tin
* Issues in change awar{ again

* Future work

James Tam

Conducting A Heuristic Evaluation

It’s a compromise between extensive style guides and
intuition-based inspections

Style guides Heuristic Inspections
evaluation

James Tam




Conducting A Heuristic Evaluation (2)

Employ a small set of evaluators (3—5) examine interface
using heuristics as a structure

*Each person evaluates the system according to the
heuristics individually (~1 — 2 hours)

Conducting A Heuristic Evaluation (3)

*After this bring the evaluators together to
pool/compare their results

James Tam




Conducting A Heuristic Evaluation (4)

Benefits of group evaluations

* Single evaluator only catches ~35% of usability problems
* 5 evaluators catch ~75%

100%
;f:? o 5%
£
5 e
50%
$53
£ 9
s e
oo
2 25%
[v§
0%
0 5 10 15

Number of Evaluators

Statistics from “Usability Engineering” by Jakob Nielsen
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Heuristic Evaluations: Who Should/Could
Conduct Them

Interface experts End users

James Tam




Heuristic Evaluations: Types Of Systems
To Evaluate

Low fidelity paper prototypes | o cowsees

Medium fidelity prototypes

Completed systems

! ".lio—] '
ey
|- » S

James Tam

Other Guidelines: Style Guides

Guidelines published by producers of graphical user
interfaces (GUIs)

*Examples:
- Open Software Foundation MOTIF
- Open Look
- MS Windows
- Apple

Describes the “look and feel” of the GUI

*e.g. Open Look
- Grouping items in the same menu:
Use white space between long groups of controls on menus or in short groups when
screen real estate is not an issue

Good, but hard too follow
* GUI and widget specific
* Vast number of guidelines
* May miss fundamental design principles

James Tam




Example Pages From Motif Style Guide, Release 1.1

Message Dialogs
Description

MessageDialogs should be used to convey a
message to the user. They must not interrupt the
user’s interaction with the application. They
should include a message, and one of the
following button arrangements.

OK

OK Help

OK Cancel

OK Cancel Help

Yes No

Yes No Help

Yes No Cancel

Yes No Cancel Help

Cancel

Cancel Help

Retry Cancel

Retry Cancel Help

Related Information
For more information, see the reference pages for
DialogBox, ErrorDialog, InformationDialog,
QuestionDialog, WorkingDialog, and
WarningDialog

Information Dialog
Description

An InformationDialog should be used to convey
information the the user. It must not interrupt the
user’s interaction with the application. It should
include an information symbol, a message, and
one of the following button arrangements.

OK

OK Help

Tllustration

- Indoraation Oialeg
i Yo vl P matl,

ebean T

ETI . ':ﬁ“jﬂ'J,,_—

Related Information
For more information, see the reference page for
DialogBox

James Tam

Other Guidelines: Widget-level “Guides”

Toolkit “hard-wires” guidelines

* Repertoire of widgets

*Look & feel of particular widgets

« Easier to use defaults then to re-invent the wheel!

Some toolkits

*Look & feel is programmer-settable or platform-dependent

Advantages:

*Easy to be consistent

* Widgets developed by experts (e.g., graphical designers)

Disadvantages
« Can be hacked around

* Interfaces “assembled” by non-interface designers can still be terrible

James Tam




You Now Know

Nine principles of design
* Simple and natural dialog
* Speak the user’s language
* Minimize user’s memory load
*Be consistent
* Provide feedback
*Provide clearly marked exits
* Provide shortcuts
* Deal with errors in a positive manner
*Provide help

James Tam

You Now Know (2)

Heuristic evaluation
* Principles can be used to systematically inspect the interface for usability
problems

Style guides are mostly platform-dependant design principles

Widget-level guidelines are built into the widgets themselves

James Tam




Goals:

Methods:

Products:

Interface Design And Usability Engineering

Articulate:
*Who (users)
*What (tasks)

Brainstorm
designs

Task
centered
system

centered
design

Evaluate

Participatoi
interaction

Task
scenario
walk-

through

Representation
& metaphors

low fidelity
prototyping
ethods

User and
task
descriptions

Throw-away
paper
prototypes

This diagram is a variation of the one presented by Saul Greenberg

Refined
designs

Psych, User,
Representationg
and metaphors

Graphical
screen design

Interface
guidelines

high fidelity
prototyping
methods

Completed
designs

Testable
prototypes

Alphal/beta
systems or

comp
specification

James Tam




